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THIS NEWSLETTER . . .

This Newsletter . . .

Dear Newsletter Readership,

as usual, this newsletter and older newsletters can be found online at
http://www.soton.ac.uk/∼fangohr/iop cpg.html. We note that all http links in the
newsletter are clickable. This has been so for many years, but becomes now more
valuable as, presumably, more people will read the newsletter online.

IoP regulations require that we print one newsletter per year, but we do not have
sufficient group funds to print and mail two newsletters. For now, we will thus print
one newsletter per year, and circulate the other one electronically only. This edition is
circulated in print (and electronically).

The main feature (page 1) of this newsletter is provided by Andrew Horsfield and
reports on Software for Non-Adiabatic Molecular Dynamics simulations.

Our Computational Tools feature in this newsletter introduces the open source Vector
Graphics program Inkscape (page 16).

As always, we value your feedback and contributions (email to Hans Fangohr at
fangohr@soton.ac.uk).

The Computational Physics Group Committee.

http://www.soton.ac.uk/~fangohr/iop_cpg.html
http://www.inkscape.org
mailto:fangohr@soton.ac.uk
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Introduction

A foundational approximation of Molecular Dynamics (MD) is the neglect of non-
adiabatic processes. The success of MD in a wide variety of contexts demonstrates just
how robust this normally is. However, there are some problems in which the exchange
of heat between electrons and nuclei is the whole story [1], and for these we need to
modify the formalism of MD to create non-adiabatic MD (NAMD).

The example that caused us and our intrepid colleagues to set off down the rocky
road of NAMD is the heating of ions by an electric current in nanowires. If you per-
form adiabatic MD in the presence of an electric current, then you obviously find no
heating of the ions. The question is then: what level of correction is needed? First
we investigated the simplest scheme that we were aware of, namely Ehrenfest Dy-
namics (ED). In ED the electrons evolve according to the time-dependent Schrödinger
equation, while the ions evolve classically. But this failed to reproduce the heating
of the ions by hot electrons, though it could produce heating of cold electrons by
hot ions [2, 3]. This asymmetry exists because each ion is treated explicitly, so their
fluctuations are visible to the electrons who can thus identify the ionic temperature.
The electrons, on the other hand, are experienced by the ions as a structureless fluid
whose temperature cannot be identified through the forces. This is a completely gen-
eral property of the Ehrenfest approximation, independent of the level of description
of the electrons.

At that time there was no non-adiabatic method that both used MD and operated
with open boundaries for the electrons, so we set out to devise one. We named the
method Correlated Electron-Ion Dynamics, or CEID (pronounced “seed”). To go be-
yond ED we introduced small quantum fluctuations in the ionic trajectories by means
of a low order moment expansion [4]. This allows the ions to probe the response of
the electrons to small changes in their trajectory from which information about the in-
ternal state of the electrons can be determined. The moments correspond to powers
of the instantaneous ionic positions and momenta relative to the mean values for the
trajectories. The first moment gave us heating, while the second moment was needed
to introduce the scattering of electrons by heated ions [5].

Since then we have entered two other fields where non-adiabatic processes are im-
portant. The first is radiation damage in metals in which very high energy ions rico-
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chet through crystalline metal, exciting electrons as they go. The Ehrenfest approxima-
tion is found to be adequate for this problem because the ions are very energetic and
heat the electrons, rather than the other way around. The second field is the response
of conjugated polymers to photoexcitation (important in photovoltaics). In order to
capture the strong non-adiabatic effects that can take place as the electrons evolve, we
had to redesign our formalism, introducing an efficient basis set expansion [6] as the
moment expansion could not be extended in a stable manner. We now have a scheme
that is very stable and can be extended systematically.

To address the above problems, we have in each case had to develop a substantial
new computer code. Below we describe these programs. If you wish to learn more
about these programs, or would like to use them as part of a collaboration, you might
like to attend a one day meeting to be held at the Institute of Physics on Monday July
13th. Attendance is free, but you need to register so we know how large a lecture
theatre we need and how much food to provide. Details of the meeting can be found
on the IoP website here. (The URL is given in the acknowledgements at the end.)

spICED

In the limit that spontaneous phonon emission may be neglected, i.e. where the ionic
temperature is much greater than the electronic, the Ehrenfest approximation result for
the rate of heat transfer between ions and electrons is good [7]. At Imperial College
London we have focussed on using the Ehrenfest approximation in a region where it
is applicable- to look at high energy ions in metals.

In a radiation damage process, incoming high energy particles collide with the ions
of the solid. The primary knock-on atoms (PKAs), hit by the incoming particles, re-
coil and go on to cause damage themselves. We have had some success assessing the
validity of simple empirical models of heat transfer between the hot ions within a dis-
placement cascade and the metallic electrons. An investigation of a single driven oscil-
lating atom within a metal [8] showed that the rate of energy transfer to the electrons
is dependent on the electronic temperature, the position of the vibrating atom within
the unit cell and even the direction of oscillation. This directly leads to anisotropy in
the non-adiabatic forces on ions.

Running Ehrenfest dynamics simulations of the early evolution of low energy dis-
placement cascades has led us to confirm that while a damping force proportional to
velocity is sufficient to model the bulk of energy transfer from ions to electrons, a larger
rate of energy transfer is seen when the ionic kinetic energy is confined to a focused
sequence of collisions [9]. Recently we have also been able to show that electronic
excitations generated during a cascade are well described by a Fermi-Dirac distribu-
tion at some elevated temperature, even in the absence of the direct electron-electron
interactions that would be required in order to thermalize a non-equilibrium distribu-
tion [10]. We are now moving on to investigating high energy ion channeling. A high
energy ion moving between crystal planes can travel a considerable distance as the
principal energy loss mechanism is through electronic stopping; MeV ions beamed at
a surface will penetrate to micron depths, allowing subsurface doping. Figure 1 shows

2

http://www.iop.org/Conferences/Forthcoming_Institute_Conferences/Correlated%20Electron-Ion%20Dynamics_Debutante/page_32107.html


SOFTWARE FOR NON-ADIABATIC MOLECULAR DYNAMICS

snapshots of radiation damage and channeling simulations possible with spICED.

Figure 1: Snapshots from simulations possible with spICED. Left: 100fs into a 1keV
cascade in 13440 copper atoms, we see the displaced atoms appear as jets along 〈110〉
directions. This coincides with where the electronic damping is at its greatest. Right: A
1MeV ion moving left-to-right down a 〈100〉 channel in a simulation of 14080 copper
atoms is somewhat ahead of the compensating screening charge cloud and leaves a
streak of negative charge on the ions it has just passed. The Hartree potential in the
plane shows a gradient against the direction of motion, indicating a Coulombic drag
on the moving ion.

To generate these results we have developed the spICED (sparse parallel Imperial
College Ehrenfest Dynamics) code. This program, primarily designed to run large-
scale (tens of thousands of atoms) tight binding dynamical simulations within the
Ehrenfest approximation, has been in development for three years and now comprises
some eighty thousand lines of code. It has been designed, as far as possible, for flexibil-
ity and robustness rather than raw speed. Its modular f95 structure contains many of
the elements of expressive programming described here in a previous newsletter [11],
with 80 derived types, all with private fields, nested up to 5 layers deep. We have
elected to use xml for all input files, linked together with XInclude to generate reusable
libraries.

spICED is parallelized with MPI, scaling well to 128 cores on HeCTOR. This scal-
ing performance is acheived by exploiting the predictable sparseness of the Hamil-
tonian in the atomic basis set. The hopping integral between atoms I and J is zero
if the distance between them is greater than some cutoff Rc. Therefore if the atoms
are indexed by z-position, and then grouped into slices of thickness greater than Rc

then the Hamiltonian becomes block tridiagonal, with block (S, S ′) linking together
atoms in slice S with those in S ′. Computing the time derivative of the electronic state
with the Quantum Liouville equation requires the commutator of the sparse symmet-
ric Hamiltonian and dense Hermitian density matrix. The commutator for block (S; S’)
requires knowledge only of the Hamiltonian and density matrix blocks neighbouring
(S; S’). Blocks from the upper triangle of the density matrix are distributed across the
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processors. An up-to-date halo of neighbouring blocks is then maintained by a local
exchange of messages each update step.

Evolving the electrons in a model metal using Ehrenfest dynamics is sufficiently
computationally inexpensive that simulations of ten thousand atoms and more are
now routine. This opens up the possibility of using simulation cells of a sufficient
size to contain the trajectories of high energy atoms; and with this the possibility of
exploring radiation damage and other phenomena with proper quantum mechanical
electrons. We have been able to study the electronic stopping of ions with a kinetic en-
ergy of eV up to MeV, and are now looking at the velocity dependence of the charges
of high energy ions in a metal. spICED offers an easy-to-use platform for explor-
ing non-adiabatic processes with tight binding simulations. It could easily be pressed
into simulation of semiconductors (by dropping in a new tight binding model); study
the response to high electric fields with fifty lines of code, or explore non-adiabatic
electronic effects in high energy surface phenomena such as sputtering just by chang-
ing an input file. The flexible code structure and good scaling means we have barely
scratched the surface of Ehrenfest dynamics simulations.

pDINAMO

The initial motivation for the development of the CEID formalism was the study of
electrical conduction in atomic wires. In the last decade, the study of electron trans-
port phenomena in nanoscale devices has undergone spectacular development. Un-
derstanding the transport properties of such nanoscale devices is crucial as the size of
present day electronic devices approaches the regime where quantum effects dominate
their functioning. Experimentally, it has now become possible to make chains of single
atoms between two electrodes, pass a current along this chain and study the effects of
the current flow on the atoms in the wire [12]. Theoretically, it has become possible
to not only calculate how much current flows through an atomic wire, but to make
predictions about the local heating of the wire, about forces that the current exerts on
individual atoms, and about the critical voltages at which the current blows the wire to
pieces [13]. These predictions have been verified experimentally [14]. More recently,
a fresh wave of theory has started to focus on the dynamical quantum description,
in real time, of current and of the interaction between current-carrying electrons and
vibrating ions in nanodevices.

The original code that implemented the CEID equations of motion was called DI-
NAMO (Dynamics In Non-Adiabatic Molecular Orbitals). This serial code was de-
veloped in-house at QUB by Dr Cristián Sánchez, now at the University of Córdoba,
Argentina. DINAMO solves a tightly coupled set of equations that are currently trun-
cated at second order in electron-ion correlations, as mentioned in the introduction.
These equations are propagated in real time for several hundred femtoseconds in or-
der to model the dynamical response of the atoms. It quickly became apparent to us
that in order to treat realistic problems, a parallel code was required. To see this, con-
sider first ED. The bottleneck in ED simulations is the quantum evolution of the elec-
tronic dynamics, which we handle by solving the quantum Liouville equation. This
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equation scales as N2 where N is the number of basis functions used in our description
of the electronic subsystem (currently tight binding models are implemented). Com-
pared to this, the algorithmic and memory costs of the second-order CEID equations
scale as (6M + 1)N2 where M is the number of dynamic “CEID” ions. Paralleliza-
tion of DINAMO commenced just over two years ago, resulting in a new code called
pDINAMO [15].

The philosophy behind the parallelization of DINAMO is to produce a fully scal-
able code that runs on a wide range of computer hardware. In light of this the most ap-
propriate parallelization method is a domain decomposition based upon the message
passing interface (MPI). DINAMO was originally designed as a layered code whereby
an application layer sits on top of a linear algebra layer. pDINAMO extends this design
through the addition of a communications layer on which the linear algebra layers sits.
Such a design minimizes disruption to the application layer but obviously it is neces-
sary to rewrite the linear algebra layer to make use of parallel methods and algorithms.
All linear algebra routines have been hand-coded in pDINAMO to exploit the under-
lying parallelism except for a number of diagonalization routines (used in preparing
an initial state for the simulations) for which we use ScaLAPACK. Two re-engineering
phases of pDINAMO have already taken place to improve the performance and scal-
ability of the code (thus increasing the range of problems that can be tackled) and to
implement additions to the continuously developing theory (such as open boundary
conditions for transport [16]). In order to produce a fully scalable code two levels of
parallelization are required: firstly, the distribution of electron-ion correlation matri-
ces (the N2 scaling); secondly, the distribution of correlation matrices corresponding
to different CEID ions (the 6M + 1 scaling). The code currently implements the first
level of parallelization. This places a limit on the number of CEID ions we can treat.
For instance, when N = 3000 we have M ≤ 12 whereas when N = 10000 we have
M ≤ 3. Implementation of the second level of parallelization is currently underway
and will allow us to treat a larger number of moving CEID ions for a given N . Cur-
rently, pDINAMO runs on a wide range of hardware ranging from desktop computers
to the HPCx and HECToR national services.

CEID, as implemented in pDINAMO, has been applied to a number of problems
in transport. In addition it has been compared with other established methods such
as the Self-Consistent Born Approximation [18]. As well as implementing the CEID
equations of motion at the second moment level, pDINAMO also implements ED as
a zeroth-moment approximation. We have recently used pDINAMO at the Ehrenfest
level to study the effect of current-induced forces on electron transport. After show-
ing mathematically that current-induced forces are not conservative we demonstrated,
through dynamical simulation, that these forces provide a new mechanism for energy
transfer from electrons to ions. This mechanism, which differs fundamentally from
Joule heating, can be gauged to do useful work on atoms. It thus provides the basis for
the ultimate atomic-scale motor, in which current flow drives and accelerates a single
atom in a circular orbit, creating an elemental waterwheel [17]. In these simulations we
considered a bent atomic chain with the corner atom allowed to move. The dynamical
response of this atom was then investigated using a nearest-neighbour single-orbital
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Figure 2: Current-induced response of the corner atom in our bent atomic wire. A 601-
atom chain (yellow), initially aligned along the vertical (y) axis is considered. Those
atoms aligned along the positive y-axis are then rotated by an angle of 70o as shown.
An electro-chemical potential difference of magnitude 1V is applied across the chain
using our open boundary method and the response of the corner atom is studied over
a timeframe of 5 picoseconds (ps). The trajectory traced by the moving atom (blue)
is shown together with a plot of the ground-state potential energy surface on which
the corner atom moves. The red lines denote equipotential surfaces. For clarity the
trajectory is traced over the simulation time 2.0–2.7ps. Further simulation details can
be found in Ref. [17]

orthogonal tight binding model (simulation details can be found in Ref. [17]). While
the waterwheel effect was uncovered in the simulations, this required specially tuned
conditions even for one moving atom. Two factors caused this sensitivity. First, in
general the two independent Einstein frequencies of the corner atom in the plane of
the bent chain are unequal which means that the ground-state potential-energy sur-
face (PES) has an easy and a hard axis. This leads to self-crossing trajectories in which
the non-conservative force does little or no net work. The second factor is the dis-
placement of the atom from the harmonic minimum, due to the current-induced force,
which additionally complicates the motion. After many parameter searches we were
able to locate both a bend angle for the chain and specific onsite energies for the mov-
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ing atom and its neighbours that minimized these two effects: with these adjustments
the new ground-state PES had approximately equal frequencies and the displacement
of the atom by the current was still within the harmonic part of the PES. Figure 2 shows
the ground-state PES obtained for a 601-atom chain together with the trajectory traced
out by the corner atom when an electro-chemical potential difference of magnitude
1V is applied across the chain. The nanowheel undergoes a series of cycles, in which
the kinetic energy rises and falls. As the orbit grows, the atom eventually leaves the
harmonic part of the well. The motion becomes erratic, the electronic friction in ED
(together with the non-conservative force which can now act as a brake) brings the
kinetic energy down, and the cycle starts again.

PolyCEID

PolyCEID is a computer code written in C to test a new version of CEID appropriate
for molecules. Indeed, in small systems one can expect quantum coherence between
electrons and ions to play a particularly relevant role. In principle, in order to deal
with subtle coherence effects, one has to resort to a higher truncation order of the
original CEID hierarchy. This was not possible within the original version of CEID,
which employs a truncation scheme based on density matrix moments [5]. Therefore
a new approach based on a direct expansion of the complete density matrix (electrons
and ions) has been devised, tested, and finally implemented in a computer code —
PolyCEID — to solve this issue.

The main idea behind this new version of CEID is to expand the quantum fluctu-
ations of ions about their mean-field (or Ehrenfest) trajectories [6]. Since ionic wave-
functions are usually well localised — with the possible relevant exception of protons
— about their trajectories, one expects the approximation made by truncating small
wavelength fluctuations to be appropriate. Indeed, the lowest order truncation of the
CEID hierarchy is equivalent to Ehrenfest dynamics, which is known to produce reli-
able results in many, yet not all, cases (see above). Therefore, by increasing the order
of the truncation in a systematic way, one expects to find better and better agreement
with the exact evolution given by the solution of the time-dependent Schödinder equa-
tion.

In order to test the convergence of the new CEID approach we originally consid-
ered simple two-level systems (2LS) depending on a single ionic coordinate. Although
extremely simplified, this model allows one to study dynamical effects beyond the
mean-field approach, i.e., Ehrenfest Dynamics. A quick comparison between the elec-
tronic level populations in the upper and lower left panels of Fig. 3 shows that a CEID
order 5 simulation (panel (b)) is already converged with respect to both the exact so-
lution (panel (a)) and higher CEID order simulations (a 10th order one is reported in
panel (a)). Surprisingly, a CEID order 0 simulation completely fails to reproduce the
oscillating behaviour of the electronic level populations. We can say, in analogy with
quantum electrodynamics, that the spontaneous emission of phonons is completely
missed by Ehrenfest dynamics since in that framework atoms are completely classical.
As a consequence, an excited electron misses a possible decay channel which turns out
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Figure 3: PolyCEID findings: Left panels, results for a resonant two-level system dis-
playing a Landau-Zener transition. Panel (a) shows the evolution of the electronic
populations acoording to the exact solution of the time-dependent Schrödinger equa-
tion. The 2LS is initially prepared in its excited state. In panel (b) population dynamics
from CEID simulations of order 0, 1, 5, and 10 are reported. Right panels, dimerization
dynamics for a tight binding model of the finite Polyacetylene chain CH2[C2H2]16CH2.
Panel (c) shows the evolution predicted by a CEID order 0 simulation (equivalent to
Ehrenfest dynamics). In panel (d) are reported results given by a CEID order 10 simu-
lation.

to be the crucial one in the simple 2LS under inspection.
Of course, quantum coherence between electrons and ions can play an important

role also in more realistic molecular models. On the other hand, since one expects
decoherence time to be shorter for systems containing many atoms, one can confine his
investigation to very short time scales, of the order of few hundreds of femtoseconds,
corresponding to very few molecular oscillations. To test the new CEID approach
in this range of scales, we studied a tight binding model parametrized to reproduce
the dynamics of excited polyacetylene chains. In this case, despite the absence of an
explicit electron-electron interaction term in our quadratic Hamiltonian, we made use
of a truncated CI expansion to properly describe the electronic degrees of freedom
of the system. Indeed, although the ground-state is well described by a single Slater
determinant, a longer many-body expansion is needed in order to reproduce the non-
adiabatic evolution of an excited state. The truncation of the CI expansion is chosen
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by taking into account the energy of the excitations (by introducing a cutoff) and the
relative contribution of the single molecular orbitals (by using a limited active space).

Once again, we found that by including some amount of quantum fluctuations of
ions, i.e., by setting a non-zero CEID order in our simulations, the predicted behaviour
of the chain dynamics dramatically changes [19]. In the right panels of Fig. 3 the plot of
the dimerization parameter Di = (−)i(Ri+1− 2Ri + Ri−1)/4 where Ri is the (averaged)
position of the i-th atom of the chain, is reported for the first 100 fs. The dimeriza-
tion parameter is the order parameter for this kind of one-dimensional systems and in
some extent it measures the local distortion of a (dimerized) chain. A larger distortion
is the fingerprint of localised excitations like excitons and polarons. One can easily
see from a comparison between panel (c) (CEID order 0) and panel (d) (CEID order
10) of Fig. 3 the dramatic effect of the electron-ion correlations on the chain dynam-
ics. The two well separated “pockets” in the dimerization plot can merge in a single
“pocket” during a high order, converged CEID simulation (lower right panel) at vari-
ance with the relatively trivial results of an Ehrenfest like (i.e., CEID 0) simulation
(upper right panel). This is another manifestation of a new decay channel opening
due to the excitability of ionic quantum degrees of freedom (i.e., spontaneous emis-
sion of phonons), in agreement with what we found for a simple 2LS. We are currently
investigating the role of these electron-ion correlation effects in the production rate
of photo-carriers in conjugated polymers, which is a sensitive parameter in designing
better performing organic solar cells.

In summary, the new CEID approach developed at UCL has been proved to be
appropriate for describing coherent electron-ion effects, especially electronic decay
triggered by spontaneous emission of phonons. We focused so far only on model
systems in order to test this new approach, but we are now moving to a better treat-
ment of the Coulomb interaction, possibly by post-Hartree-Fock methods. The final
goal of our effort is to provide a tool to study the effects of the electron-electron and
electron-phonon interactions at the same time in order to improve the description of
non-adiabatic processes in realistic molecular systems.
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Ehrenfest: correlated non-adiabatic molecular dynamics. J. Phys.: Condens. Matter,
16(46):8251–8266, 2004.

[5] A. P. Horsfield, D. R. Bowler, A. J. Fisher, T. N. Todorov, and C. G. Sànchez. Cor-
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COMPUTATIONAL PHYSICS GROUP NEWS

Computational Physics Group News

The Computational Physics Thesis Prize 2008

The Committee of the Institute of Physics Computational Group has endowed an an-
nual thesis prize for the author of the PhD thesis that, in the opinion of the Committee,
contributes most strongly to the advancement of Computational Physics. A total prize
fund of up to £250 will be divided between the prize-winner and the runners up.
The number of awards is at the discretion of the Committee. The winner(s) would be
expected to provide an article for the IoP Computational Physics Group Newsletter.

. The deadline for applications is July 15th, 2009.

. The submission format is a 4 page (A4) abstract (pdf) together with a citation
(max. 500 words) from the PhD supervisor and a confidential report from the
external thesis examiner. Further details may be requested from shortlisted can-
didates.

. The submission address is:
DR NUNO LOUREIRO
email: Nuno.Loureiro@ukaea.org.uk

. Please enclose full contact details, including an email address.
Applications are encouraged across the entire spectrum of Computational Physics. The

competition is open to all students who have carried out their thesis work at a University in
the United Kingdom or the Republic of Ireland, and whose PhD examination has taken place
in 2008.

International Union of Pure and Applied Physics: Young Scientist
Prize in Computational Physics

The “International Union of Pure and Applied Physics Young Scientist Prize in Com-
putational Physics” (IUPAP Young Scientist Prize) can be awarded to researchers who
have a maximum of 8 years research experience following their PhD.

The annual deadline for applications is 1 March.
See http://c20.iupap.org/prizes.htm for details.
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RESEARCH STUDENT CONFERENCE FUND (TRAVEL AWARDS)

IoP Computational Physics Group - Research Student
Conference Fund (Travel awards)

The Computational Physics Group (CPG) of the Institute of Physics (IoP) is pleased
to invite requests for partial financial support towards the cost of attending scien-
tific meetings relevant to the Group’s scope of activity. The aim of the scheme is to
help stimulate the career development of young scientists working in computational
physics to become future leaders in the field.

Further details can be found at

http://www.iop.org/activity/grants/Research Student Conference Fund/page 26535.html
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UPCOMING EVENTS

Selected Upcoming Computational Physics Events

Computer Simulation and the Environment

. Thursday, 10 September 2009

. Institute of Physics, London

. A one day meeting at which the first three speakers will talk about computer
intensive modelling of physics related to the environment, followed by two pre-
sentations from hardware vendors on what the next generation of hardware will
be like.

. Further information: http://www.iop.org/ConferencesSept2009

European Workshop on Monte Carlo Treatment Planning

. 19-21 October 2009, Cardiff, UK.

The introduction into clinical practice of more accurate computational algorithms for
radiotherapy dose calculation is of paramount importance and algorithms based on
the Monte Carlo (MC) method are widely regarded as the most accurate available.
MC techniques are also ideal research and development tools increasingly used in
emerging areas including, among others, functional imaging and molecular targeted
radiotherapy. The number of publications reporting the use of MC in radiotherapy
treatment planning (MCTP) has increased exponentially in the last 25 years.

The aim of MCTP2009 is to provide a forum to present and discuss developments
and clinical implementations of MC technology in all aspects of medical radiation
physics devoted to the diagnosis and treatment of cancer.

. See http://www.mctp2009.org/ for further details.
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UPCOMING EVENTS

Conference on Computational Physics (CCP) 2009

. 15-19 December 2009, Kaohsiung, Taiwan

. Abstract submission deadline is 30 June 2009

. See http://www.ccp2009.tw/ for details

CCP is the worlds largest conference on Computational Physics. It is an annual
event, rotating between the continents of Asia-Australia, Europe-Africa, and North
and South America. In previous Asia-Australia rotations, it graced: Gyeongju, Korea
2006, Beijing, China 2003, Brisbane, Australia 2000.

Scientists in any area of computational physics are welcome to participate. Sub-
fields such as Condensed Matter, AMO, Plasma/Space, High Energy, QIS, Complex
Systems, Education, New Method form the major program, Petaflop and GPU Super-
computing.

Even in December, Taiwan has beautiful weather. The culture, cuisine and scenery
will make the visit refreshing in addition to academic enriching.

Condensed Matter and Materials Physics (CMMP 09)

. 15 - 17 December 2009

. Warwick University, UK

. http://www.iop.org/Conferences/Forthcoming Institute Conferences/CMMP09/page 32870.html
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COMPUTATIONAL TOOLS: AN INTRODUCTION TO INKSCAPE

Computational tools: An introduction to Inkscape

In this brief tutorial we review what vector and bitmap graphic formats are before we
demonstrate how to annotate a simple graph with Inkscape (http://www.inkscape.org),
a vector graphics drawing program based on the scalable vector graphics (SVG) for-
mat.

Vector graphics

In vector graphics, any graphical element is stored through the coordinates, connec-
tions and mathematical shape. For example, a straight line could be stored as a start-
ing position (x and y coordinates) together with the vector that describes the length
and direction of the line. Additional data is required to store the color, width, layer,
shape of the corners etc. of the line. File formats that use vector graphics include EPS,
Postscript (PS), PDF and SVG. Programs that can be used to create vector graphics
include Inkscape, Xfig, MS Visio, OmniGraffle, Adobe Illustrator, Xara Xtreme, Corel-
DRAW.

Vector graphics is the ideal format for any scientific graphs, such as standard x-y
plots of, say, y=f(x), as one can arbitrarily zoom into the data without losing resolution.

Bitmaps

The other common way to store graphics are bitmaps. Here, a fixed resolution is used,
for example 640x480 pixels, and each pixel carries a certain colour. This is the ideal
format for photographic images which cannot be described efficiently by mathemati-
cal expressions. Typical file formats are JPEG, PNG, TIFF, BMP and GIF. Programs for
bitmap manipulation include The Gimp, Adobe Photoshop, ImageMagick, Paint Shop
Pro.

Case study Inkscape

Creating the sample graph

We often need to annotate a graph, for example to add extra labels, add arrows to par-
ticular data points, overlay images, include insets etc. While this often can be achieved
through the graph plotting software (which could be Gnuplot, Xmgrace, Python, Mat-
lab, etc.), it is sometimes more time efficient to use another program to add the labels,
in particular if this plot only needs to be labelled once.

Let’s assume we use this Python program

from pylab import *
x=arange(0,10,0.1)

y=sin(x)

figure(figsize=(6,4)) #make figure 6 inch wide, 4 inch high

plot(x,y)
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COMPUTATIONAL TOOLS: AN INTRODUCTION TO INKSCAPE
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Figure 1: The toy dependence for y = f(x): a pdf file created with Python.

xlabel(’x’)

ylabel(’y=sin(x)’)

savefig(’myplot.pdf’)

to create a simple plot of y = sin(x) and to save the graph to a PDF file myplot.pdf

Installing Inkscape

Next, we want to add a label and an arrow to the plot. For the purpose of this
demonstration we do this using Inkscape. Inkscape can be freely downloaded from
http://www.inkscape.org and is available for all major operating systems.

The following sections describe how the graph shown in figure 1 (page 17) can be
imported to Inkscape, and annotated to create the diagram shown in figure 2 (page
19).

Importing the graph

Once Inkscape is started and the user interface window appears, we import myplot.pdf
using File->Import (the default settings in the dialog are fine, just confirm them
with OK). The mouse can be used to drag the diagram to the desired location on the
page, or to scale it by clicking on it and dragging the arrow-shaped handles at the
corners; press CTRL while dragging to maintain the aspect ratio.
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Adding the text label

To add the text, we click on the text button (a large letter A), click somewhere on the
canvas, and type “left turn”. The desired font size and style can be chosen from the
toolbar or by using the text properties dialog (Text->Text and Font).

We move the text object to the desired location on our plot by switching to the Selec-
tor tool (which is indicated by an arrow pointing to the upper left corner of the square
button) and dragging the text with the mouse. One way of rotating (and changing the
size of) the text object, other than by mouse, is to use Object->Transform->Angle
where we enter -70 degrees, and apply.

Adding the arrow

Next we switch to the Pencil tool (indicated by a pencil with a scribbly line on the
button) and drag with the mouse roughly along the lower part of the graph to create
a curve following it.

When switching to the Node tool (whose button is directly below the Selector tool
and shows three blue rectangular dots with a black arrow) we see that the curve’s
overall shape is determined by just a few nodes. This is typical of vector graphics and
guarantees that there is no loss of quality when zooming. Clicking on one of these
nodes displays handles for fine-tuning, and by dragging the nodes and their handles
we can adjust the curve so that it neatly follows the function graph.

Finally, to add the arrowhead we open the Fill & Stroke dialog (Object->Fill
and Stroke), switch to the Stroke style tab and choose Arrow1Mend from the End
Markers dropdown menu. If desired, the dialog can also be used to change the stroke
thickness, color, etc.

Saving the completed figure

Before we save, we reduce the canvas size to only include the drawn objects (and not a
full A4 sheet), through File->Document Properties->Fit Page to Selection.

We can save the resulting SVG file (File->Save) and export to PDF using File->Save
as and select PDF as the output format (again, just confirm the default settings with
OK). The result is shown below.

Outlook

Inkscape capabilities go very far beyond what has been described here. The purpose
of this article is simply to point to this (emerging) vector graphics program, and to
give some indication of its ease of use. For some seasoned computational scientists
this may serve as a modern version of Xfig (for some applications), others may create
complete posters using it. In fact, Inkscape would have been able to create the simple
x-y plot above (Effects->Render->Function Plotter), but this would detract
from the use case shown here.
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Figure 2: The annotated version (arrow and text ’left turn’ added with Inkscape.)

There is a wide selection of tutorials (Help->Tutorials) which are a great place
to quickly see different possible uses of Inkscape. There is also extensive documenta-
tion (Help->Manual) and a lot of further tips and info on the Wiki (use the link on the
main web page http://www.inkscape.org to get there). Last but not least, it has a very
active and friendly community and you are encouraged to ask questions or report any
problems on the mailing lists (see website).

Hans Fangohr, Maximilian Albert
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RELATED NEWSLETTERS

Related Newsletters

The Computational Physics Group works together with other UK and overseas com-
putational physics groupings. We list their newsletter locations here:

. Newsletter of the Computational Physics Division of the American Physical So-
ciety:

http://www.aps.org/units/dcomp/newsletters/index.cfm

. Europhysicsnews newsletter of the European Physical Society (EPS):

http://www.europhysicsnews.org/

. Newsletter of the Psi-k (Ψk) network:

http://www.psi-k.org/newsletters.shtml.

. The bulletin of the Knowledge Transfer Network for Industrial Mathematics,
providing information for industrial and academic collaborators on recent re-
sults, milestones and opportunities. The full bulletin is available at:

http://www.industrialmath.net/content/news.
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COMPUTATIONAL PHYSICS GROUP COMMITTEE

Computational Physics Group Committee

Roger Barrett (Web editor) R.Barrett@surrey.ac.uk
Peter Borcherds (Vice-chairman) p.h.borcherds@birmingham.ac.uk
Alan DuSautoy (Honorary Secretary) alan.dusautoy@npl.co.uk
Hans Fangohr (Newsletter) h.fangohr@soton.ac.uk
Andrew Horsfield (Treasurer) a.horsfield@ucl.ac.uk
Vera Hazelwood Vera.Hazelwood@smithinst.co.uk
Geraint Lewis (Chairman) dg.lewis@physics.org
Nuno Loureiro (Thesis prize) Nuno.Loureiro@ukaea.org.uk
Ian Morrison i.morrison@salford.ac.uk
Jesus Rogel j.rogel@physics.org
Michael Sleigh Michael.Sleigh@awe.co.uk

IoP Computational Physics Group links:

. Group webpages (http://www.iop.org/activity/groups/subject/comp)

. Newsletters (http://www.soton.ac.uk/∼fangohr/iop cpg.html)

Comments about the newsletter, letters and contributions for future editions are wel-
come and can be sent to Hans Fangohr.
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